
Chapter 10  Using Crystal Reports

This chapter provides a structured approach to preparing reports with Crystal 
Reports.
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Using Crystal Reports

The approach of this chapter in preparing reports with Crystal Reports includes 
the following elements:

q deciding on the content of your report,

q developing a prototype on paper,

q setting up the prototype using Crystal Reports,

q manipulating the data with formulas and functions,

q grouping, summarizing, and sorting your data,

q editing and formatting the data,

q specifying the records/groups to be included in the report, and

q printing the finished report.

This is not a hands-on chapter, but an important introduction that can make your 
report creation work more efficient and more satisfying. The chapter has been 
designed to provide you with a conceptual understanding of Crystal Reports as 
well as a brief introduction to Crystal Reports' powerful features. 
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Deciding on the Content of Your Report

Before you do anything else, you should outline the information you want your 
report to provide. Use the following list of questions as a guide in making that 
outline:

q What is the overall purpose of the report?

q Who is going to read the report?

q What is the report title going to be?

q What information do you need besides the title to identify the report?

- Where is that information to come from?

- If the information exists in a database, what types of fields is the data 
stored in: number, text, etc.?

q What identifying information do you want to appear at the bottom of each 
page?

- Where is that information to come from?

- If the information exists in a database, what types of fields is the data 
stored in: number, text, etc.?

q What specific data do you want to appear in the body of the report?

- Where is that data to come from?

- Does that data exist in data fields or does it need to be calculated from 
data field values?

- What kind of fields is the data stored in: number, text, etc.?

- Do you want to show totals?

- What kind?

- What do you want to total?

q What information, if any, do you want flagged on the report?

- How do you want it flagged?

q What information do you want highlighted in some way so that it really 
stands out?

q Do you want the report to be based on all records in the database or only on 
specified records?

Purpose

What is the overall purpose of the report?
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Reports are management tools. Their purpose is to help individuals quickly 
grasp the essential elements and relationships found in raw data so they can 
make effective decisions. For a report to be effective, it has to present the right 
data in a logical way. If it presents the wrong data or if it presents the right data 
in a haphazard manner, the report may slow the decision making process or 
even encourage incorrect decisions.

A good starting place in the development of a report is to write out the purpose 
of the report in a sentence or two. The purpose statement helps you focus on 
your primary needs, and it gives your report both a starting point and a goal. 
Here are some examples of purpose statements:

q The purpose of this report is to show monthly and year-to-date sales by 
sales rep, compare this year's numbers to last year, and flag reps who are 
seriously deficient.

q The purpose of this report is to show sales activity for each item in 
inventory, and to suggest reorder quantities based on that activity.

q The purpose of this report is to calculate bowling averages and handicaps 
for each member of the bowling league.

Clarifying the purpose of the report before you start is a critical step in the 
overall process. A report without a clear purpose is like a meeting without a 
clear agenda; it rambles and accomplishes little.

Readers

Who is going to read the report?

A single report is often used by many individuals. A detailed, company-wide 
sales report, for example, may be used by sales reps, the regional sales manager, 
the national sales manager, and the Chief Operating Officer (COO). 

Each of these individuals will be interested in different aspects of the report.

q A sales rep will use the report to evaluate his/her individual sales 
performance and to compare that performance to that of other reps in the 
region.

q The regional sales manager will use the report to evaluate the reps in his/her 
region and to compare the region's performance to that of other regions. 

q The national sales manager will use the report to evaluate the performance 
of his/her regional managers and to compare overall sales to the current 
sales forecasts.
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q The COO will use the report to evaluate the performance of the Vice 
President of Marketing and the sales department as a whole, and to project 
such things as manufacturing needs, warehouse locations, etc.

Since each of the users of the report has different interests, it is important to 
plan the report so it includes the information each of the users is looking for.

Title

What is the report title going to be?

Write out a working title for your report. You may decide to change it later, but 
at least you will have a title to use when creating your prototype report.

Other Header Information 

What information do you need besides the title to identify the report?

Are you going to include identifying information in addition to your report 
title? You may wish to include the current date, information on who prepared 
the report, a block of text to describe the purpose of the report, the range of data 
covered, etc. If you are going to include such information, write it down so you 
can use it in preparing your prototype.

Header Information Sources

Where is that information to come from?

The information can come from a variety of sources, depending on the kind of 
information you plan to use. For example, the current date can be inserted using 
the Crystal Reports Insert|Print Date Field command. Information on who 
prepared the report might be drawn from individual data fields in the 
database(s) used. (If it is to be drawn from a database, what database? Or, what 
combination of databases?) A block of text can be created and entered on the 
face of the report itself. As you begin to think of where the information is to 
come from, you begin formally structuring the report.

Data Types in the Header

If the information exists in a database, what types of fields contain the data: 
number, text, etc.?
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Crystal Reports uses different rules for working with different types of data. 
You will find it helpful later if you note the data type of each piece of data you 
plan to draw from a database.

Footer Information

What identifying information do you want to appear at the bottom of each page 
(page number, report name, author's name, “Confidential,” etc.)?

Footer Data Sources

Where is that information to come from?

Data Types in the Footer

If the information exists in a database, what types of fields is the data stored in: 
number, text, etc.?

Report Body Data

What specific data do you want to appear in the body of the report?

When you think of a report, it is probably the body of the report that you think 
of. The body should contain all the data that you need to fulfill the statement of 
purpose you wrote for the report. It should also contain all of the data needed by 
the various users that you have identified. You might find it helpful to list first 
the basic data that is required to fulfill the purpose statement, and then list the 
more specific kinds of data needed by the various users.

Body Data Sources

Where is that data to come from?

This step requires you to look at the available databases. Crystal Reports allows 
you to combine data from different databases to create your reports, so you 
have a great deal of flexibility in your work.

q Much of the data in a typical report will be taken directly from data fields. 
Which data fields will you be using and where are they located?
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q Other data will be calculated based on data fields. Which data fields will be 
used in the calculations?

q Still other data will be input directly into the report (headings, text blocks, 
etc.). Which data will enter directly on the report, without drawing it from 
data fields?

Existing or Calculated?

Does that data exist in data fields or does it need to be calculated from data field 
values?

Some report information can be drawn directly from data fields (sales 
information, for example); other information will have to be calculated based 
on data field values (sales commission, for example, based on the relationship 
of sales to quota). In your planning, it can be helpful to segregate or flag data 
that needs to be calculated from that which can be used directly.

Data Types in the Body

What kinds of fields contain the data: number, text, etc.?

While it is important to understand data types for all data you will be using, it is 
of critical importance that you know the data type for data fields that will be 
used in calculations. Functions and operators work with specific kinds of data, 
so it's important to know the data type to know which functions and operators 
you can use in your calculations.

Groups

Do you want your data organized into groups? How do you want it grouped? 
By customer? By date? 

Group Values

Do you want to show a subtotal at the end of each group? A count? An 
average? Crystal Reports allows you to specify several kinds of group values.

Group Value Positions

Where do you want the group values to appear. With the group data? With the 
group data but on a page separate from other groups? Only at the bottom of the 
page?
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Crystal Reports gives you all of these options.

Grand Totals, Grand Total Averages, etc.

Do you want to total (or average, count, or determine the maximum or 
minimum value included in) all the values in any column on your report?

Crystal Reports allows you to do this and place the grand total (or the grand 
total average, grand total count, etc.) at the bottom of the selected column.

Flags

What information, if any, do you want flagged on the report?

You may want to call attention to some data by flagging it on your report. For 
example, non-moving inventory items are often flagged on inventory reports so 
they can be given special attention. If you want any information flagged, 
identify the information and the parameters for flagging. Using the inventory 
report example, you might want to flag each item that has shown no activity 
during the last month, during the last three months, or during some defined 
period.

Flag Options

How do you want it flagged?

You may want to flag items with an asterisk or some other symbol, or you may 
want a word to appear as a flag. In any case, you should write out flagging 
instructions so they are handy.

Highlights

What information do you want highlighted in some way so that it really stands 
out?

Crystal Reports gives you the opportunity to underline report elements, or to 
change the fonts or font size used for specific report items. All of these 
formatting tools can be used to highlight key data on a report. If you have data 
that you want highlighted, you should write down highlighting instructions so 
they are handy too. 
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Record or Group Selection

Do you want the report to be based on all records or groups in the database or 
only on specified records or groups?

Crystal Reports gives you the opportunity to base a report on all records in a 
given database, or on a limited set of records from the database. Using Crystal 
Reports you can select records based on simple date ranges or comparisons, or 
you can create complex formulas to identify the records to be included. Take a 
few minutes to determine the records needed for your report and list the criteria 
to be used for selecting those records.

Sorting

Do you want your data sorted based on record or group values?

Crystal Reports gives you both alternatives.
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Developing a Prototype on Paper

Graphic designers generally begin their work on a magazine cover, brochure, or 
display advertisement with a rough pencil sketch. They often use boxes, circles, 
or other symbols to represent the graphic elements they intend to include in the 
final product, and they often use lines or scribbles to represent text. Doing the 
rough design on paper, in pencil, helps them create a “look” for each page. It 
helps them find a balanced way of positioning the various elements before they 
begin working with sophisticated graphics tools. We think you will find a 
similar exercise helpful in designing your Crystal Reports reports.

While a paper prototype is useful regardless of your expertise with Crystal 
Reports, it is particularly valuable when you are first learning to use the Crystal 
Reports program. With the paper prototype at hand, you can put your full effort 
into learning and using the Crystal Reports commands instead of trying to 
design and learn at the same time.

Use the following procedure to design a paper prototype with Crystal Reports.

q Get paper of the size you'll be using for your finished report.

q Position your title and other descriptive header information, using boxes or 
lines to represent report elements.

q Position your footer information.

q Review the page for balance.

q Look at the information you intend to include in the body of your report.

- Count the number of fields you will be using and estimate the 
appropriate spacing between fields.

- Use rectangles to pencil in the fields using your estimated spacing.

- Change the spacing if necessary.

- Decide on a logical sequence for presenting the report data.

- Label the fields to indicate that sequence.

q Use small boxes to indicate group values and totals.

q Place some random flags where you want the flags to appear.

q Darken any elements you want highlighted so they stand out from the rest 
of your prototype.

q Review your finished product for look and balance, and make changes as 
needed.
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Setting Up the Prototype Using Crystal Reports

Once you have completed your paper prototype, it is a straightforward process 
to recreate that prototype in the computer, using Crystal Reports. Before you 
do, it is important to understand how Crystal Reports' report editing process 
works.

NOTE:
This section assumes that you are new to Crystal Reports and that you plan to 
build a simple report using data from a single database. No advanced topics 
are covered in this section.

When you want to begin a new report, Crystal Reports displays the Choose 
Database File dialog box. Use this dialog box to select the database file(s) that 
contain the data you want to use in your report. You will first select the 
directory and, once in the directory, you can select the database file you 
identified earlier in Deciding on the Content of Your Report.
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The Report Editor

Once select your database, Crystal Reports displays the Report Editor screen. 
Use this screen to insert and format data and to watch your report take shape.

When you open a new report, Crystal Reports automatically creates three 
sections in the Report Editor:

q A Page header section – this section is generally used for the report title, 
field headings, and other information that you want to appear at the top of 
each page.

q A Details section – this section is the body of the report. The bulk of your 
report data will generally appear in this section.

q A Page footer section – this section usually contains the page number and 
any other information that you want to appear on the bottom of each page.

The name of each section appears in the gray area to the left of the Report 
Editor edit box.

q Build your report by inserting data fields, formulas, and other report 
elements (record counts, record numbers, etc.) in the Details section of the 
editor. Use the Insert menu, in most cases, to select or create the elements you 
want to insert on the report. The Report Editor uses rectangular element 
markers to indicate the size, position, and data type of the report elements you 
have inserted.

q You add subtotals (and other group values) by selecting a field to subtotal 
and then telling Crystal Reports the conditions that are to generate a new 
subtotal or group value (change of customer number, change of sales rep, etc.). 
Crystal Reports creates group value sections as needed and places the group 
value in the section. Again, Crystal Reports uses rectangular field boxes to 
represent the group values.

q Insert grand totals in the Grand Total section. This section appears when 
select the field to total and then select Insert|Grand Total. Crystal Reports uses a 
rectangular field box, this time to identify the field in the Grand Total section of 
the Report Editor.

q You can add freeform text anywhere on the report by positioning the text 
cursor in the section in which you want the text to appear, typing in the text, 
and then using the Tab key to move it into position. You can also type freeform 
text in a text field; this allows you to avail yourself of additional formatting 
options (alignment, hide options, etc.).
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Auto-Scrolling Capabilities

The Report Editor has auto-scrolling capabilities. That is, whenever the cursor 
hits one of the edges of the Report Editor when you are placing, resizing, or 
moving a field or drawing a graphic line or box, the Editor automatically scrolls 
to reveal more workspace (if more is available).

Resizing Sections

The Report Editor first appears with default section sizes. You can expand or 
reduce report sections by dragging the lines that separate the sections. When 
you position the I-beam cursor over one of those lines, the cursor changes to a 
double-arrow resizing cursor. Once that cursor appears, you can resize as 
needed. Alternately, to expand a report section, you can click the section of 
interest and press Enter as many times as needed. Once you've expanded a 
section, you can reduce it by deleting unneeded lines with the Backspace key.

A Word about Databases, Records and Fields

Before we go any further, a discussion of databases, records, and fields is in 
order. A record is the basic building block of a database. Each record contains 
data about a single entity (a customer, an order, etc.), and each database 
contains at least one record. The data in each record is stored in fields (holding 
spaces). Each field holds one piece of data known as a value. The database from 
which you will create a report is a collection of related records. A customer 
database, for example, is a collection of records that each contain data on a 
single customer.

Records and Fields in Row/Column Reports

Think of the data in a database as being stored in horizontal rows and vertical 
columns.

CustNumber Fname Lname
01034456 Bill Brown

01034457 Jane Doe

01034458 Bob Jackson

01034459 Mary Jones

The table shows field values for four records from such a database (in this case 
a customer database). 
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q Each row represents one record. All of the data in that row is about a single 
customer, but the data is broken into three distinct pieces: customer number, 
first name, and last name. Each of those pieces represents a value found in a 
field on that record, the CustNumber, Fname, and Lname fields respectively 
(as indicated by the column headings).

q Each column represents one field. All the data in a given column represents 
the values that appear in that field on each of the records in the database.

The structure of a row/column report corresponds to the structure of a database 
with rows representing individual records and columns representing individual 
fields. 

Records and Fields in Data Block Reports

Some reports do not follow the row/column format, however. Instead, some 
group related data in data blocks. A mailing list, for example, typically uses 
several rows for each record: a row for the company name, a second row for the 
street address, a third row for the city, state and ZIP code, etc. In such a report 
all the data for a given customer in the list appears in a block. Each block 
represents a single record even though the data in the block spans several rows. 

Data Types

The data type of a field, (string, number, currency, date, Boolean, or memo) 
determines the type of information that can be stored in that field and which 
will print in the report column. 

Fields of each data type display on your screen like this:

XXXXXXX String — for example, a company name, account description or 
customer name.

$5,555,555.55 Currency (Paradox/Btrieve files only) — for example $500.00 or 
$50,000,000.00-.

5,555,555.55 Number — for example 120 or 5555.

YYYY-MM-DD Date — for example Oct 10 90.

YES/NO Boolean (YES/NO) data fields — for example, the result of a 
formula which compares a customer's credit limit to see if it is 
greater than $5000 and prints YES if the credit limit is more than 
that amount; NO if it is less than that amount.

XXXXXXX Memo — a paragraph describing a piece of property, comments 
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regarding a job applicant, a summary of a movie plot, etc.

Formatting, and Record and Group Selection

While formatting, and record and group selection will be covered in depth later, 
there are a few things about those subjects that are worthwhile to cover here:

q Currency, date, and Boolean fields are shown above in the default format. 
This format is used for both the element markers (in the report editor) and 
for the report elements themselves (in the report). If you want your data to 
appear in a different format on your report, you can make the desired 
changes using the Format|Field command.

NOTE:
The characters in the element markers change to reflect font changes and 
many formatting changes (alignment, etc.).

q The width and position of a field (when place it in the Report Editor) 
determines the initial spacing between fields and the order in which the 
fields will print across the report page.

q When insert a data field in your report, Crystal Reports assumes that you 
want to pull data from all the data records in the selected database. To limit 
the records (or groups of records) used in your report, you need to tell 
Crystal Reports how to identify the records or groups of records you want 
to include. Using Edit Record Selection Formula or Edit Group Selection 
Formula on the Print menu, you can build the selection formula that fits 
your needs.
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Building Your Prototype

To build your report you will follow these steps:

q Select the database(s) you wish to use in your prototype report.

q Enter and position the data fields, text, and titles you want included in the 
header, footer, and body of your report.

q Print your report to the Print Window and review your work.

q Make whatever changes are necessary.

q Insert your totals, subtotals and other group fields.

q Enter and position any formula fields that will calculate or manipulate data 
or create flags.

q Print your report to the Print Window and review your work.

q Format the report elements that you want to stand out in some way from the 
others. 

Selecting the Database(s)

Use the File|New Report command to begin a report from scratch. That 
command leads you to a dialog box from which you can select the first database 
you wish to use. To select additional databases, use the Database|Add File to 
Report command.

Entering and Positioning Data Fields

Enter and position data fields using the Insert Database Field dialog box that 
lists available fields in the selected database. Make your selections from the list, 
and then place the field in your report using the rectangular field placement 
cursor that appears.

Adding Text

You can add text to your report by typing it at the text cursor and then moving it 
into place. Move the I-beam cursor to the line on which you wish to enter text 
and click the left mouse button to set the text cursor at the left edge of the 
Report Editor. Then, simply type in your text, move the I-beam cursor in front 
of it, and push it into position using the Tab key or Space Bar. You can also add 
text by inserting text fields and positioning them as you would any other field.
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Entering Field Titles

By default, Crystal Reports automatically inserts a field title whenever insert a 
new field or formula field. The title is a text field that can be edited. The left 
edge of the title field aligns with the left edge of the field it identifies. To toggle 
this feature off use the File|Options command.

Printing and Reviewing

You can print and review your work in progress at any time using the Print|Print 
To Window command. When select this command, Crystal Reports prints your 
report to the print preview window. 

Making Changes

Move a database field by dragging it to a new position with the mouse, or by 
selecting it and using the Arrow keys. You can move a field within its 
originating section or to other sections of your report if you wish. Delete a field 
by selecting it and then pressing the Delete key or selecting Edit|Clear.

NOTE:
To select multiple fields at one time, press the Shift key and, while keeping it 
depressed, click the various fields you want to select. Handles will appear on 
each field selected. When finished, you can move or delete the selected fields 
as a group.

Placing Totals, Subtotals, and Other Group Values

Place grand totals by selecting the numeric or dollar field you want to total, and 
then selecting Insert|Grand Total from the Menu Bar.

Select group values (subtotals, group averages, group counts, etc.) by first 
selecting the field you want grouped. Then select the kind of group value you 
want, using the Insert|Subtotal or Insert|Summary commands. Select the kind of 
group value you want (if selected Insert|Summary). Then select the field that 
the program uses to sort and group your data by and the sort direction.

Moving Group Values

Move a subtotal or summary by dragging it to a new position with the mouse, 
or by selecting it and moving it with the Arrow keys. You can move subtotals 
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and summaries only within their originating sections, or from the group footer 
section to the group header section for the subtotal or summary of interest.

Entering Formulas

Enter formulas using the Insert|Formula command. This command calls up the 
Formula Editor. Using the Formula Editor, build your formula using fields, 
functions, and operators, and check your work using the built in formula 
checker.

Formatting

You can change the font or point size using the Format|Font command. You can 
change the alignment and printing characteristics of field data using the Format|
Field command, and you can change the conditions that trigger subtotals, add 
page breaks, suppress blank lines, hide selected sections, etc. using the Format|
Section command. 

Once you have built a prototype report, you have a working model that you can 
customize to meet your specific needs.
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Manipulating the Data with Formulas and Functions

Crystal Reports uses formulas and functions to help Create reports more quickly 
and easily. It uses them also to allow you to do the kind of “number crunching” 
and data manipulations that are necessary for advanced reporting.

 Formulas

A formula is a set of instructions that may be used to calculate information you 
cannot obtain directly from database data fields. For example:

q A database record may have a Qty1 field and a Qty2 field but no field that 
sums both quantities. If you want the sum of these two fields to appear on 
your report, you need a formula that adds the value in one field to the value 
in the other. 

q A database record for a sales rep may contain the field GrossSales and you 
want to use 120% of that gross as the sales quota for the following year. To 
accomplish this you need a formula that multiplies GrossSales by 120%.

q A database record for a one product company may contain a field Revenue 
that expresses total dollar sales for the year. You're interested in 
determining the number of units sold based on an average price of 49.95 per 
unit. To accomplish this you need a formula that divides Revenue by 49.95.

All of these examples require simple formulas: {file.Qty1} + {file.Qty2}, 1.20 * 
{file.GrossSales}, and {file.Revenue}/49.95 respectively. These formulas all use 
Crystal Reports operators (+, * [multiply], / [divide]) and they're all easy to 
create and understand.

But not all of your information needs can be reduced to simple formulas; some 
needs require extensive calculations or manipulations. For example:

q You want to determine your average monthly unit sales for the last year, 
rounded to the nearest unit.

q You want to convert ounces of inventory to pounds and ounces, and have it 
appear in the format x pounds y ounces.

The formulas required to accomplish these activities require a fair amount of 
data manipulation: rounding, averaging, converting numbers to text, calculating 
remainders, etc. While some of the manipulations (averaging, calculating 
remainders) can be done using Crystal Reports operators alone, others cannot 
be done without the use of functions. And even the ones that can be done 
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without functions can be done more quickly and efficiently with them. (For 
additional information on formulas, see Crystal Reports Help.

Functions

A function is a preset procedure or subroutine used to evaluate, make 
calculations on, or transform data. For example:

q the NumericText function evaluates the contents of a text field to see if it is 
a number, and

q the UpperCase function transforms all lowercase characters in a string to 
uppercase.

When you specify a function, Crystal Reports performs the set of operations 
built into the function without requiring you to specify each operation 
separately. For example:

q the Average function sums a list of values and divides the sum by the 
number of values in the list.

q the DayOfWeek function extracts the day component of a date, determines 
the day of the week the date falls on, and converts the day of the week to a 
number (1-7) where Sunday is the first day of the week.

By performing multiple operations with a single command, these kinds of 
functions are a kind of shorthand that make it easier and less time consuming 
for you to create reports. But not all functions involve lengthy calculations; 
some simply allow you to do things that you couldn't do easily without them 
while others take the drudgery out of report creation. For example:

q the ToNumber function converts a number that has been stored as text, to a 
number that can be used in calculations, and

q TrimRight removes all the spaces to the right of a string of data stored 
left-justified in a database.

How Functions are Used

Functions are used in formulas. In fact, a single function and its required 
argument(s) may include the entire formula. For example, Abs 
({file.TestResult}) is a perfectly acceptable, stand-alone formula for calculating 
the absolute value of the field TestResult.
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Function Syntax

Each function comes with its own set of usage rules (syntax). These rules must 
be followed for the function to perform correctly. If they are not, Crystal 
Reports displays a Formula Compiler Error message.

As an example, the correct syntax for using the Average([array]) function is:

Average ([array])

« where array is an array of constants, field values or calculation results, 
separated by commas. »

Translated, this means that to use the Average([array]) function correctly, you 
should enter: 

Average 

followed by a list of numeric values, separated by commas, with the list of 
values enclosed in brackets, and with the array enclosed in parentheses. Thus:

Average ([1,2,3,4,5]) 

is an example of the correct way to use the Average([array]) function.

If you try to use the function:

q without separating the values by commas,

q without enclosing the values in brackets, 

q without enclosing the array in parentheses, 

q while including any unnecessary characters, or 

q with values that are not numeric,

Crystal Reports won't accept the formula and will display a Compiler Error 
message identifying your error.

Entering Formulas and Functions

Formulas and functions are entered via Crystal Reports' Formula Editor.

The Formula Editor is a dialog box that contains all the tools you need to create 
and check the correctness of formulas. Using the Editor, you:

q assign a name to your formula, 

q enter the formula, 
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q check it to make sure you have entered it correctly, and then 

q accept it for use in your report. 

When you accept it, Crystal Reports places the formula in your report in the 
position selected for it. Then, when you print the report, Crystal Reports prints 
the results of the formula instead of the formula itself.

The Fields Box

You can enter fields into your formulas in two ways: via the Fields box, or 
manually.

q To enter a field via the Fields scroll box, move the I-beam cursor to the 
place you want to insert the field and click the left mouse button to set the 
text cursor at that point. Then you locate the field you wish to insert from 
the Fields scroll box list.

- Fields already in use in the report are grouped at the top of the list; 
other available fields follow. 

- Formulas you have entered are listed next, their names preceded by the 
@ sign.

- All other fields available in the active databases are listed last, grouped 
by database.

Select a field. Crystal Reports inserts the selected field (complete with the 
required syntax elements) at the text cursor.

NOTE:
Select an item from the Formula Editor scroll boxes (Fields, Functions, or 
Operators) by double clicking it, or by clicking it once to highlight it and then 
clicking the Select button at the bottom of the Editor to complete the selection 
process. 

q To enter a field manually, you locate the text cursor in the appropriate 
position and type in the field name as you would any text. 

q The correct syntax for a database field name is: 

{file.fieldname}

If you: 

- do not include the file name,

- leave out the separating period, or 

- fail to surround the expression in braces, 
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Crystal Reports will generate a Formula Compiler Error message detailing 
your error.

q The correct syntax for a formula field is:

{@formulaname}

Operators and Functions Boxes

You can also enter operators and functions into your formula in one of two 
ways: manually or via the Operators and Functions scroll boxes. 

q To enter an operator or function manually, you locate the text cursor in the 
appropriate position and type in the operator or function as you would any 
text. 

q To enter an operator or function via the lists in the Functions and Operators 
scroll boxes, set the text cursor where you want the entry to appear in the 
formula. 

- Then select the item of interest from the scroll box lists. Crystal Reports 
inserts the selected item in your formula, complete with any 
parentheses, brackets, or commas required.

NOTE:
For an array of items, only the first comma is included. As enter additional 
items into an array, you will need to type in commas to separate the items.

Order of Precedence

When entering formulas that contain different kinds of operators, it is important 
to consider order of precedence, the order in which Crystal Reports performs 
the operations in your formula. 

You learned simple order of precedence in high school math: when performing 
calculations, do multiplication and division first, then addition and subtraction. 
Thus:

5 + 10 X 3 = 35

The calculation 10 x 3 is performed first to get 30. 30 is then added to 5 to 
arrive at the final answer.

Now if your intention is to add 5 to 10 and then multiply the sum by 3, you 
have to modify the order of precedence with parentheses. You can do that thus:
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(5 + 10) x 3 = 45

It's clear that parentheses have a higher precedence than the add, subtract, 
multiply, and divide operators. They redirect the order of calculation.

You learned all of this in school and Crystal Reports follows the same rules of 
precedence. But Crystal Reports uses many additional operators, and it's 
important for you to understand the precedence Crystal Reports assigns to each 
so you can write your formulas to perform as expected.

q In the following list, Crystal Reports performs the top level operations first, 
then the second level, then the third, and so forth.

q When it encounters two or more operations that are on the same level, it 
performs them left to right. 

Level 1 Parentheses, Array, IfThenElse

Level 2 Call, Subscript

Level 3 Identity, Negate, Dollar, Not

Level 4 Multiply, Divide, Percent

Level 5 Add, Subtract

Level 6 To

Level 7 Less than, Greater than, Greater than or equal, Less than or equal, In

Level 8 Equal, Not equal

Level 9 And

Level 10 Or

Using Dates in Formulas

Crystal Reports includes many useful functions for including dates and date 
ranges in formulas; you will learn more about those functions in Crystal 
Reports Help. At this point, however, it's useful to know how to enter any date 
into a formula. 

Enter a date simply by entering the Date function (manually or via the Function 
button) and then providing the date of interest in the parentheses that follow in 
the form YYYY,MM,DD (1992,01,01 = January 1, 1992). 
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The Formula Checker

The Formula Editor also contains a formula checker which checks the syntax of 
your formula. If the syntax is incorrect, the formula checker points out the 
location of the problem and tells you what the problem is. You activate the 
formula checker by selecting the Check button. Crystal Reports also checks the 
formula automatically when you choose Accept. When debugging formulas, 
especially if you have entered them manually, look carefully for:

q missing quotation marks around text strings, 

q missing database name accompanying field names,

q missing braces around database name/field name combinations,

q missing closing parentheses to match opening parentheses, 

q case differences (the Formula Checker is case sensitive),

q if-then-else formulas that use different data types for the then and else 
actions, and

q using X instead of * for multiplication.

The Formula Editor is easy to use and can be called up by selecting Formula 
from the Insert menu.

Developing Complex Calculations with Formulas

Crystal Reports allows you to combine fields, functions, and operators to create 
complex calculations and manipulations of data. For example, to test the 
drawing power of two different offers, you can use a single Crystal Reports 
formula to send one offer to all customers with an even customer number and a 
second offer to all customers with an odd customer number. You can do some 
remarkable manipulations using Crystal Reports formulas.
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Grouping, Summarizing, and Sorting Your Data

Crystal Reports allows you to group, summarize, and sort your data to achieve 
the reporting results you want.

Grouping the Data

A group is a set of records that are related to each other in some way. In a 
customer list, for example, a group could consist of all those customers living in 
the same ZIP code, or in the same state. In a sales report, a group could consist 
of all the orders placed by the same customer, or all of the orders generated by a 
specific sales rep. 

Breaking data into groups (and then doing something to evaluate the group data, 
if you wish) is a key part of effective reporting. In fact, it's what separates a 
report from being merely a presentation of raw data and a valuable 
communication tool.

Crystal Reports allows you great flexibility in grouping data. It also allows you 
to create a number of different kinds of group values.

Group Values

A group value is the value generated as the result of an evaluation, a tally, or a 
calculation performed on data from a single group. A subtotal is one kind of 
group value; it is the sum of all of the values from a single field, from all the 
records in a group. In a sales report, for example, if you subtotal sales by sales 
rep, Crystal Reports gathers all the records that belong to the sales rep and totals 
the sales amounts from all the records. In a group average, Crystal Reports 
averages the values in a group of records; in a group count, it counts the values 
in a group of records, etc. Group values are important tools for creating 
powerful reports. Crystal Reports gives you several alternatives for working 
with group data. It enables you to:

q calculate the sum of values, 

q calculate the standard deviation or variance of the values,

q average the values, 

q count the values, 

q determine the highest value, and

q determine the lowest value in the group.
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Grouping Data with Crystal Reports

While there may be many data fields on a report, there is typically only one 
field for which you are interested in grouping the data. In a sales report, for 
example, it would probably be the field listing the amount of sales; in a 
commission report, it would probably be the field listing the amount of 
commission, etc. To group data you first select the field you want to group 
together.

Once the field is selected, select the action you want to take on each group of 
data from that field:

q If you want to simply group the data and take no further action, you can 
select Insert|Group.

q If you want to subtotal it, you can select Insert|Subtotal. 

q If you want to average, count, determine the maximum or minimum value, 
etc., you can select Insert|Summary.

Subtotals and summaries make up the category of group fields.

NOTE:
The Insert|Subtotal command is simply a shortcut for setting up a summary that 
adds the values in each group.

Once you have selected the group field and the action, select another field (a 
sort and group by field) that triggers a grouping whenever its value changes. In 
grouping your data by state, for example, you would use the state field to create 
a new group (and generate a group value if selected) whenever the state 
changes. Likewise, the ZIP code field would trigger a grouping whenever the 
ZIP code changes.

Once you've made these simple selections, Crystal Reports does the rest. Your 
data will be grouped, and the group value (if you have selected one) will be 
calculated and will accompany each group.
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Summarizing the Data

Crystal Reports provides three easy-to-use summarizing options:

Grand Total A grand total adds all values in a field for the entire report and prints 
the sum on the last page.

Subtotal A subtotal is a partial total, a total of a specific, limited group of data 
in a field.

Summary A summary summarizes field data from a specific, limited group of 
records. It can total the data like a subtotal, but it can also average the 
values, count the values, or determine the highest or lowest value in 
each group or field.

All of these options are available on the Insert menu.

The Summarizing Process

The process of summarizing the data on your report follows these steps:

1. Selecting the field you want to summarize.

2. Selecting the summarizing option you want from the Insert menu.

Finally, if select Subtotal or Summary as a total type, the process will also 
include the following step:

3. Selecting the data field that triggers a new subtotal/summary whenever 
its value changes.

Selecting a Field to Total

To select the field you want to summarize, click on it with a mouse. Crystal 
reports puts handles on the selected marker to highlight it as selected.

Selecting a Total Type

To select a total type, select it from the Insert menu or pop-up menu.

Selecting a Field to Trigger a New Subtotal

If select Subtotal or Summary as a total type, Crystal Reports asks you to 
indicate the field that is to trigger a new subtotal/summary whenever its value 
changes. 
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Sorting

There is a logic to the way values are arranged when they appear in a column 
on your report. Initially, they are arranged in the same order as the data appears 
in your database. But data can be sorted in a variety of ways:

q A mailing list, for example, could be sorted in ascending order, on the ZIP 
code field; that is, the customers would be sorted so that those with the 
lowest ZIP codes would appear first and those with the highest ZIP codes 
would appear last. 

q It could also be sorted in ascending alphabetical order, on the last name 
field; that is, customers with last names beginning with A would appear 
first and those with last names beginning with Z would appear last. 

q It could also be sorted by street address or customer first name if you had 
some practical reason for doing so. 

Crystal Reports gives you the opportunity to change the existing sort order 
using the Print|Record Sort Order and Print|Group Sort Order commands.

Sorting by Record

When use the Print|Record Sort Order command, Crystal Reports asks you to 
select two things:

q the field you want your sort to be based on (sort field), and

q the sort direction.

Sort Field

A sort field is a field that determines the order in which data appears on your 
report. Crystal Reports sorts field data using Windows' sort comparison 
algorithms, and it uses rules specific to the Country select in the International 
section of the Windows Control Panel.

You can use any field as a sort field. A field's data type determines the method 
in which the data from that field is sorted: 

Text Text fields are sorted in the following manner:

One character values are sorted so that blanks have the lowest value, 
then punctuation, then numbers, then uppercase letters, and finally 
lowercase letters. 

Then two character values are sorted, then three, etc. using the same 
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rules. As a result:

“BOB” comes before “bob”, 

“123" comes before ”124", 

“ ” (blank) comes before “a”, and 

“aa” comes before “aaa” 

Dollars Dollar fields are sorted in numeric order.

Number Number values (120, or 5555) are sorted in numeric order.

Dates Date fields are sorted in chronological order.

Booleans Comparison fields are sorted so that false values come first, then true. 

When select a sort field, Crystal Reports sorts the values from that field.

Sort Direction

Direction refers to the order in which the values are printed, once sorted. 

q Ascending order means smallest to largest, 1 to 9, A to Z, False to True.

q Descending order means largest to smallest, 9 to 1, Z to A, True to False.

Single Field Sorts

Single field sorts are sorts in which all the data in the report is sorted based on 
the values in a single field. Sorting an inventory report by stock number and 
sorting a customer list by customer number are examples of single field sorts. 

Multiple Field Sorts

In multiple field sorts, Crystal Reports first sorts the entries (alphabetic or 
numeric) in the first field selected, putting them in ascending or descending 
order as specified. Then it sorts any entries in the second field that can be sorted 
without disturbing the sort order of entries in the first field. It then sorts any 
entries in the third field that can be sorted without disturbing the sort order of 
the entries in the first two fields. It follows the same pattern for sorting 
additional fields.

Sorting Groups

Crystal Reports allows you to change the order in which groups appear on your 
report. You can:
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q base the sort on any group (subtotal or summary) in your report, and

q sort your report so that group field values appear in ascending or 
descending order.

You change the sort order using the Print|Group Sort Order command. When 
you sort by group, nothing happens to the sort order of the records within a 
group; only the relative positions of the groups themselves change.
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Editing and Formatting the Data

Crystal Reports makes it easy to edit and format your data. The 
editing/formatting process follows these steps:

1. Selecting the data you want to edit or format.

2. Selecting the editing or formatting action you want to take place. 

3. Entering the specifics of the action in the dialog box/editor if/when it 
appears.

Selecting the Data

To select the data element you want to edit or format, click on it with your 
mouse. Crystal Reports draws handles on the element marker to highlight it as 
selected.

Selecting the Action

Once the element is selected, select the editing or formatting action from 
Crystal Reports' Edit or Format menus. For example:

q to change the font used to print the data, select Font from the Format menu,

q to hide the field when printing, select Field from the Format menu, or

q to modify a formula, select Formula from the Edit menu.

Entering the Specifics

In those cases where a dialog box or editor appears after you've selected an 
action, enter the specifics of that action in the window that appears. For 
example:

q in the Font dialog box, enter the font and point size you wish to use, and 
indicate whether you want the data to appear in boldface or italics, or 
whether you want it to be underlined or overprinted with the strikeout 
character, and

q in the Formula Editor, Make the changes you want to the formula that 
appears, check those changes if you wish, and accept the revised formula 
when you're finished. 

Crystal Reports takes it from there and performs the action selected.
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NOTE:
In some cases you have to specify a second action to complete the editing 
change desired. For example, to move some text in your report, you first cut the 
text from its current position, and then you paste it in its new position. In such a 
case select the data and then the action (Cut) to cut the text to the clipboard. 
Then you mark the new position using the insertion pointer and select Paste to 
insert the text in the new position.
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Specifying Records/Groups to be Included

When select a field to appear on your report, Crystal Reports, by default, prints 
field values from every record in the selected database. But in many cases you 
may not want to include all the values, but only a specific range of values. For 
example, you may want to include only a specific group of customers or a 
specific range of account numbers out of the total number of values in the 
database. Or you may want to include values from only those records that fall 
within a particular date range. With Crystal Reports this is easy. The program 
includes four commands on the Print menu for restricting your report to specific 
records or groups of records:

Select Records

This option allows you to limit your report to specific records that fit a 
condition or conditions you specify. It automatically builds a record selection 
formula using your responses to dialog box questions. This option requires no 
knowledge of the Crystal Reports formula language.

Edit Record Selection Formula

This option also allows you to limit your report to specific records that fit a 
condition or conditions you specify. It takes you to the Formula Editor where 
you can manually build a record selection formula to fit your needs. This 
command is intended for users who are familiar with the Crystal Reports 
formula language.

Select Groups

This option allows you to limit your report to specific groups that fit a condition 
or conditions you specify. It automatically builds a group selection formula 
using your responses to dialog box questions. This option requires no 
knowledge of the Crystal Reports formula language.

Edit Group Selection Formula

This option also allows you to limit your report to specific groups of records 
that fit a condition or conditions you specify. It takes you to the Formula Editor 
where you can manually build a group selection formula to fit your needs. This 
command is intended for users who are familiar with the Crystal Reports 
formula language.

Select the command, specify the records or groups of records you want 
included, and your report prints using only the selected records or groups.
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Printing the Finished Report

When you want to print your report or when you want to see what your report 
will look like when printed, you can use Crystal Reports' three printing options:

q printing to the printer for hard copy output

q printing to a print window to review your work

q printing to a disk file for use with other applications

All of these options are available on the Print menu.

When you are creating a report, you will find yourself printing to the print 
window often, in order to check placement and formatting of the various report 
elements. The print window even includes a print preview function that lets you 
see each page of your report as a whole, top to bottom. Then, when you want to 
print a final or interim copy of the report for hands-on review, you can print to 
the printer for hard copy output. 

If you want to use your report data in another application (in a spreadsheet or 
word processor for example), you can print the report to a disk file in any of a 
variety of popular file formats. Once in a disk file, you can import the data into 
your other application following the importing procedures established by the 
receiving application.
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